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Preface:  
  
The   manual   is   a   short   start-­up   guide   for   configuration   of   SIEMENS,   SIMATIC   S7  
programmable   controllers   and  Profibus-­DP   communication   network   based  on  TURCK  
Profibus-­DP  IO  blocks.  It  provides  the  first  time  user  of  SIEMENS,  SIMATIC  S7  industrial  
automation  technology  brief  insight  into:  
  

•   Creating  new  project  
•   Configuring  communication  interface  
•   Configuring  DP  network  
•   On-­line  IO  data  monitoring  

  
The  manual  is  a  supplement  to  SIEMENS  STEP  7  V5.2  documentation  library.  Users  are  
encouraged  to  refer,  regarding  different  S7  architectures  and  configuration  procedures,  
to  the  following  documentation:  
  
SIEMENS  

Configuring  Hardware  and  
Communication  Connections  
STEP  7  V5.2  
Order  #:  6ES7810-­4CA06-­8BA0  
  

SIEMENS  
SIMATIC  
Working  with  STEP  7  V5.2  
Getting  Started  
Order  #:  6ES7810-­4CA06-­8BA0  
  

     
Or  to  visit  Siemens  Industrial  Automation  Systems  web  site:  
  

http://www2.automation.siemens.com/simatic/portal/index_76.htm  
  
  
  
  
Trademarks:  

SIMATIC  ®,  SIMATIC  HMI  ®  and  SIMATIC  NET  ®  are  registered  trade  marks  of  
SIEMENS  AEG.  
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New  Project  Wizard  
  
Start  STEP  7  and  follow  new  project  setup  wizard  instructions  using  SIMATEC  Manager  
Tool:  
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Select  CPU  type,  set  MPI  address  and  press  “Next”  
Use  default  MPI  address.  
	
  	
  

	
  
	
  
“There  is  a  difference  between  assigning  addresses  to  nodes  and  assigning  IO  addresses  
to  input  and  output  data.  
  
Node  addresses  are  addresses  of  programmable  modules  (MPI,  PROFIBUS,  Industrial  
Ethernet  addresses);;  they  are  required  in  order  to  be  able  to  address  the  various  nodes  
in  a  subnet,  for  example,   in  order  to  download  a  user  program  to  a  CPU.  You  will   find  
information   on   assigning   node   addresses   in   the   subnet   in   the   chapter   on   networking  
stations.  
    
Input/output  (I/O)  addresses  are  required  in  order  to  read  inputs  and  set  outputs  in  the  
user  program.”1  
	
  
	
   	
  

	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
1 STEP 7 – Help File 
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Select  functional  blocks  to  be  used  in  the  project  and  press  “Next”:  
	
  

	
  
	
  
	
  
Select  type  of  programming  language  to  be  used  later:  
  

•   STL   -­  Statement  List  
•   LAD   -­  Ladder  Logic  
•   FBD   -­  Block  Diagrams  

  
OB1  represents  the  highest  programming  level  and  organizes  the  other  blocks  in  the  S7  
program.  You  can  change  the  programming  language  again  at  a  later  date.  
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Enter  new  project  name  and  press  Finish:  
	
  

	
  
	
  
SIMATIC  Manager  will  create  a  new  “Tech  Lab”  project  and  open  new  project  page:  
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HELP  
  
Extensive  “Help”  support  is  available  for  information  on  SIMATIC  MANAGER  tool.  
	
  

	
  
	
  
	
  
	
  

Terminology  
	
  
SIMATIC  MANAGER  displays  project  structure  in  the  Project  Directory  window  on  the  
left  side  pane.  
Right  side  pane  is  an  extension  of  the  project  directory  and  provides  a  content  of  the  
selected  directory  item.  
  
The  terms  used  for  particular  objects  are  defined  in  the  Help  file  as  follows:  
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Project  View  
  
Projects  are  used  for  storing  the  data  and  programs  which  are  generated  when  you  
create  a  limited  automation  solution  in  an  orderly  way.  The  data  belonging  to  a  project  
include  the  following:  

•   Configuration  data  for  the  hardware  used  and  parameter  assignment  data  for  
modules  

•   Configuration  data  for  network  communication  
•   Programs  for  programmable  modules  

	
  

	
  
	
  

Station  View  
	
  
You	
  insert	
  a	
  SIMATIC	
  station	
  (for	
  example,	
  SIMATIC	
  300)	
  if	
  you	
  want	
  to	
  configure	
  a	
  
programmable	
  control	
  system	
  (S7,	
  M7,	
  C7).	
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Processor  View  
	
  

	
  
	
  
Processor  view  defines  object  that  processor  interacts  with:  

•   Program  Objects:  The  "S7  Program"  object  is  a  folder  for  blocks,  source  files,  
and  charts  for  programmable  S7  modules  (module,  programmable).  It  also  
contains  the  symbol  table.  

•   Connection  Object:  This  object  is  used  for  determining  the  communication  
connections  (connection  configuration).  By  double-­clicking  this  object,  you  gain  
access  to  the  network  view  (the  connection  table  for  this  module  is  then  opened).  

	
  
	
  

Program  Module  View  
	
  

	
  
	
  
Program  module  view  defines  source  code,  block  and  symbols  used  in  a  project:  

•   Sources:    The  source  file  folder  is  used  for  saving  text  or  graphic  source  files;;  for  
example,  STL  source  files,  SCL  source  files,  or  Graph  source  files.  

•   Block:    The  block  folder  is  used  to  store  the  following:  
o   Logic  blocks,    
o   Data  blocks  (DB),    
o   System  data  (a  double-­click  on  this  object  displays  a  list  of  the  system  
data  blocks  (SDB)),    

o   Variable  tables  (for  monitoring  and  modifying  variables).  
•   Symbol  Object:  The  symbol  table  is  used  to  store  symbols.  
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Configuring	
  S7	
  Interface	
  
	
  
Communication  between  STEP  7  and  SIMATIC  S7  processor(s)  depends  on  interface  
card  used  in  the  application.  SIMATIC  Manager  enables  testing  and  setting  up  the  
communication  interface  as  follows:  

•   Check  for  default  communication  settings  by  selecting  

  “PLC>Display  Accessible  Nodes”  menu  function  or  simply  click  on     icon  
  

	
  
	
  

•   The  Manager  opens  new  communication  window,  goes  online  and  shows  
available  connections  on  the  right  part  of  the  window:  
	
  

	
  
	
  

	
  
•   If  connection  does  not  exist  (no  MPI=  2  address  on  the  right)  ,  close  current  MPI  
window  and  go  to:    
“Options>Set  PG/PC  interface”  
menu  function  and  select  (highlight)  type  of  interface  that  is  used  to  connect  PC  
to  S7  processor:  
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•   Select  type  of  interface  that  is  used  in  the  application  and  press  “Properties”  
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•   Use  “Station  Parameters”  field  to  define  connection  between  PC  and  interface  
card,  

•   Use  “Network  Parameters”  field  to  define  connection  between  interface  card  and  
S7  processor.  Set  transmission  rate  to  maximum  allowed  value  and  adjust  
highest  node  address  to  fit  your  network  architecture.  	
  

	
  
	
  

•   Set  PC  communication  port  by  selection  “Local  Connection”  tab:  

	
   	
   	
  
•   Save  settings  by  pressing  “OK”  and  close  all  property  and  setup  windows.  
•   Repeat  above  steps  until  communication  is  ok.  Settings  will  be  downloaded  to  
S7.    
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Configuring  Profibus-­DP  Network  
  
Open  Station  view  and  Double-­click  on  Hardware  icon.  This  action  will  open  separate    
“Hardware  Configuration“    window.  
	
  

	
  	
  

Hardware  Configuration  Window  
It  consists  of  two  regions:  

•   Hardware  Catalog  
•   Station  Window  
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Station  Window  
	
  
The  station  window  is  a  window  of  the  HWCONFIG  application  in  which  the  components  
from  the  ”Hardware  Catalog”  window  are  placed.    
All  other  actions,  such  as  dragging  connections  or  the  setting  of  module  parameters  
also  take  place  in  the  station  window.  
The  station  window  is  split  into  two  sections:  

•   The  upper  half  of  the  station  window  contains  the  racks  in  the  form  of  small  
configuration  tables  with  DP  slaves  displayed  as  symbols.  The  connections  
between  the  interface  modules  and  the  configuration  of  DP  master  system  is  only  
visible  in  the  upper  half  of  the  station  window.  

•   The  lower  half  of  the  station  window  contains  the  detailed  view  of  the  rack  or  DP  
slave  selected  in  the  upper  half.  Additional  controls  (e.g.  the  “Pack  Addresses”  
button  for  ET  200S)  can  be  displayed,  depending  on  which  object  is  shown  in  the  
bottom  half  of  the  station  window.  It  also  shows  an  IO  map  overview.  

•   Buttons  for  Navigating  in  the  Detail  View  

Hardware  Catalog  
  
The  Hardware  Catalog  window  provides  all  racks,  modules,  and  interface  sub-­modules  
that  can  be  used  to  configure  your  structure.  

Use         Hardware  Catalog  key  to  display  or  hide  the  catalog.        
  

Open  the  catalog  with  the  “View  >  Catalog”    menu  command  or  press       key  

	
   	
  
	
  
(1)  You  can  use  the  "Profile"  drop-­down  list  to  set  different  catalog  profiles.  These  profiles  
enable  you  to  customize  the  hardware  catalog  to  meet  your  needs.  
    
(2)  The   field  below   the  drop-­down   list   is   used   to   select   the   components   that   you   can  
configure   and   assign   parameters   to   with   STEP   7.   These   components   are   listed  
alphabetically   in  a   tree  structure  similar   to   that   in   the  Windows  Explorer.  To  provide  a  
better  overview,  components  of  the  same  type  (i.e.  CPU-­300)  are  grouped  in  folders  in  a    
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hierarchical  structure.  The  number  of  components  may  be  greater  if  optional  packages  
are  installed.  A  "pluggable"  component  is  represented  by  a  symbol.    
This  symbol  is  either  accompanied  by  the  order  number  or  the  version  number  if  several  
firmware  versions  are  grouped  under  one  order  number.    
  
  (3)  The  field  below  the  one  used  to  select  components  contains  information  about  the  
components  selected.  It  provides  a  brief  description  of  their  primary  function  and  thus  
helps  you  to  make  the  correct  selection.  
  

Adding  Profibus_DP  Network  
  
Highlight  DP  slot  in  the  rack  table:  

	
  
	
  
Select  “Edit>Master  System>Insert”  menu  function:  
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Insert  DP  network:  
	
  

	
  
	
  
	
  
Right-­click  on  the  “Profibus(1):  DP  master  system(1)”    symbol  
Open  network  DP  master  system  properties.  You  need  to  define  communication  
properties  by  clicking  on  “Property”  tab  
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Set  “Highest  address”,  “Transmission  rate”  and  “Profile”  values.  
	
  

	
  
	
  
Once  the  network  parameters  are  defined,  confirm  “OK”  new  settings  and  closed  
windows.    
  
Back  to  hardware  catalog,  you  will  be  able  to  add  devices  from  the  “Hardware  
Catalog”  that  will  participate  in  the  DP  network  architecture.  
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Adding  Nodes  
Steps  include:  

•   Expand  the  list  and  look  for  nodes  in  the  Hardware  Catalog.  
•   If  devices  do  not  exist  in  the  list,  install  GSD/GDE  profiles  into  the  Hardware  
Catalog.  

•   Highlight  device,  drag  and  drop  node  on  the  DP  network  line  
•   “Device  Property  Window”  comes  up.  Select  “Parameters”  tab  and  specify  node  
address.  Hit  OK  to  save  settings  and  close  property  window.  

  
Note:  Make  sure  that  node  address  and  data  rate  of  devices  added  to  DP  network  
match  with  Profibus-­DP  network  properties  that  were  previously  defined  in  the  project.  
	
  

	
  
	
  

	
   	
  
	
  
	
   	
  



	
  

	
   20	
  

The  first  node  is  added  to  the  DP  network.  Station  window  shows  just  added  node  
parameters:  

	
  
	
  
	
  

Click  on  right  arrow  icon       to  change  station  view  and  show  device’s  IO  map.  

	
  
	
  
Continue  adding  nodes  until  done.  
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Adding  Modular  Nodes  
  
Each  modular  node  may  have  different  module  structure,  such  as  BL20  and/or  BL67  
devices,  Siemens  ET200x  series,  etc.  
	
  

Procedure  requires  that  
each  slice  is  separately  
entered,  just  as  any  
stand  alone  module.    
  
When  first  of  a  kind  
module  needs  to  be  
dragged  and  dropped  
into  configuration  use  the  
first  defined  module  in  
the  list,  for  example:  

  
  
Any  subsequent  module  
of  the  same  type  use  
secondly  defined  
module,  
for  example:  

  
  
Note:  
“T”  stands  for  “type  
specific”  module  gsd  
configuration  file.  
  
“S”  stands  for  “generic”  
module  gsd  file	
  

	
  
When  done,  BL67  device  configuration  looks  like:  
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Reviewing  DP  Network  Configuration  
  
The  hardware  configuration  of  completely  defined  network  looks  like:  
	
  

	
  
	
  
	
  
From  this  point  it  is  necessary  to:  

•   Check  IO  map  
•   Print  some  data  
•   Save  configuration  
•   Download  configuration  to  PLC    
•   Go  online    
•   Verify  communication  
•   Verify  IO  map  

	
  
	
  

Check  IO  Map  

Press  Address  Overview  button         to  check  IO  data  mapping.  Filtering  check  boxes  
enable  viewing  of  input  only,  output  only  or  entire  IO  maps.  Print  map  for  your  records.  
“DP”  column  indicates  DP  node  address.  “Addr.”  Indicates  PLC  memory  offset  address.  
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Input  map  overview  page:  
	
  

	
  
	
  
Output  map  overview  page:  
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Save  Hardware  Configuration  
	
  
Save	
  Hardware	
  configuration	
  by	
  pressing:	
  

•   “Save”	
  button:	
  	
   	
  	
  or	
  

•   “Save	
  and	
  Compile”	
  button	
   	
  	
  or	
  	
  
•   go	
  to	
  “File	
  >	
  Save”	
  	
  or	
  	
  “File>Save	
  and	
  Compile”	
  menus	
  

	
  

	
  
	
  
	
  

Download  Configuration  

Download	
  configuration	
  to	
  the	
  PLC	
  using	
   	
  button	
  or	
  “PLC>Download”	
  menu	
  function:	
  

	
  
	
  
Follow	
  instructions	
  on	
  the	
  screen.	
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ON-­LINE  Data  Monitoring  
	
  
Once	
  the	
  hardware	
  configuration	
  is	
  downloaded	
  to	
  the	
  PLC	
  processor	
  and	
  DP	
  network	
  brought	
  
on	
  line,	
  you	
  may	
  use	
  various	
  ways	
  to	
  monitor	
  IO	
  data	
  of	
  the	
  devices	
  connected	
  to	
  the	
  DP	
  network.	
  
	
  

Input  Data  Monitoring  
Procedure:	
  

•   Open	
  off-­‐line	
  Hardware	
  Configuration	
  application	
  

•   Go	
  on-­‐line	
  by	
  pressing	
  	
   	
  	
  button	
  
•   Click	
  on	
  the	
  DP	
  network	
  a	
  device	
  to	
  be	
  monitored	
  
•   Select	
  input	
  or	
  output	
  data	
  at	
  the	
  device	
  data	
  map	
  e.g.	
  FLDP-­‐IOM	
  88-­‐0002	
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•   Select	
  “PLC>Monitor/Modify”	
  menu	
  function	
  
	
  

	
  
	
  

•   Check	
  “Monitor”	
  box	
  	
  on	
  the	
  on-­‐line	
  display	
  of	
  the	
  device	
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Output  Data  Monitoring  
	
  
Procedure:	
  

•   Follow	
  the	
  same	
  procedure	
  as	
  above	
  to	
  monitor	
  /	
  force	
  outputs	
  to	
  desired	
  state	
  
•   For	
  each	
  output	
  	
  in	
  “Modify	
  value”	
  column	
  enter:	
  

o   0	
  	
  to	
  turn	
  output	
  OFF	
  
o   1	
  	
  to	
  turn	
  output	
  ON	
  

•   A	
  single	
  or	
  multiple	
  outputs	
  may	
  be	
  at	
  a	
  time	
  
•   Press	
  “Modify	
  Value”	
  button	
  to	
  execute	
  command	
  
	
  

	
  
	
  

	
  

Important:  do  not  forget  to  restore  initial  output  states  before  closing  application.  
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